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10+ tips to get more out of Windows XP 

Use the PushD command to create a quick temporary drive map
This tip applies to both Windows XP Home and Windows XP Professional. 

Have you ever been working from a Command Prompt and needed to temporarily map a drive letter to a network 
location for a quick file operation? Of course, you can switch over to Windows Explorer and use the Map Network 
Drive command on the Tools menu. 

While this is a viable solution, it requires multiple steps to create—and then you have to perform several more 
steps to disconnect the network drive. This can be a pain, especially if you just want to work from a Command 
Prompt. 

However, there is another way. You can use the PushD command to quickly create a temporary drive map while 
remaining in the Command Prompt. You can then use PopD to quickly disconnect the network drive. Here’s how: 

1. Open a Command Prompt window. 

2. Type the following command line:  
PUSHD ServerSharepath 

where \\Server\Share\path is the network resource to which you want to map a drive letter.  

The PUSHD command will instantly map a drive letter to the network resource and then change to that drive right 
in the Command Prompt window. When you’re finished, just type POPD and the mapped drive letter will be 
disconnected and you’ll return to your original drive. 

Keep in mind that, the PUSHD command allocates drive letters from Z: on down and will use the first unused 
drive letter it finds. 

 
 

Uncover Windows XP’s built-in image resizing utility
This tip applies to both Windows XP Home and Windows XP Professional. 

If you’ve ever had to resize a group of digital picture files, you’ve likely launched your image editing program and 
then resized each image individually—this is an extremely time-consuming task. Windows XP has a built-in image 
resizing utility buried inside the Send Pictures Via E-Mail dialog box that can quickly and easily resize a large 
group of digital picture files at once. Follow these steps: 

3. Press [Windows]E to launch Windows Explorer. 

4. Make sure the Tasks pane is visible. (The Folders button acts like a toggle switch. If the Tree pane is 
showing, clicking the Folders button will display the Tasks pane. Click the Folders button if the Tree pane is 
showing.) 

5. Open the folder containing the group of digital pictures you want to resize. Select the group. 

6. Under the File And Folder Task list, choose E-Mail The Selected Items. 

7. When you see the Send Pictures Via E-Mail dialog box, click Show More Options to expand the dialog box. 

8. Select a radio button next to one of the available sizes and click OK. A new mail message window containing 
the resized digital pictures as attachments will appear. 

9. Pull down the File menu, select the Save Attachments command, and save all the attachments to a different 
folder. 

10. Close the mail message window and click No in the Save Changes dialog box. 
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Add a Create New Folder icon to the Quick Launch toolbar
This tip applies to both Windows XP Home and Windows XP Professional.

Creating new folders to store files is a basic Windows XP task, but Windows Explorer does not have a button to 
make it easy. You can create your own shortcut by adding a Create New Folder button to the Quick Launch 
toolbar. Follow these steps: 

1. Press [Windows]E to launch a new Windows Explorer window. 

2. Navigate to C:\Documents and Settings\{Username}\Application Data\Microsoft\Internet Explorer\Quick 
Launch. ({Username} is your account name.) 

3. Create a new folder in the Quick Launch folder and name it Create New Folder. You will see a new button on 
the Quick Launch toolbar called Create New Folder. 

4. To create a new folder, hold down [Ctrl], drag the Create New Folder icon from the Quick Launch toolbar, and 
drop it in the folder in which you want to create a new folder. You will see a new folder, and the Create New 
Folder icon will remain on the Quick Launch toolbar. 

 
 

Re-enable icon transparency on your desktop
This tip applies to both Windows XP Home and Windows XP Professional. 

Have you ever changed your desktop theme or just your desktop background and discovered that the text for your 
desktop icons is no longer transparent? Instead, you now have a colored background box behind the text. If you 
have experienced this situation, chances are that you searched high and low for a solution, but were unable to 
find one. 

That’s because the setting that allows you to control the icon transparency is poorly named. Rather than choosing 
something makes sense, Microsoft named the setting Use Drop Shadows For Icon Labels On The Desktop. To 
make matters worse, this setting is buried in the Performance Options dialog box instead of appearing in the 
Display Properties dialog box. 

In any case, sometimes that act of changing a desktop theme or desktop background inadvertently disables the 
Use Drop Shadows For Icon Labels On The Desktop setting. Fortunately, re-enabling is it easy. Here’s how: 

1. Access the Control Panel and double-click System. 

2. When you see the System Properties dialog box, select the Advanced tab. 

3. Click the Settings button in the Performance section. 

4. When you see the Performance Options dialog box, scroll down the list and select the Use Drop Shadows For 
Icon Labels On The Desktop check box. 

5. Click OK twice—once to close Performance Options dialog box and once to close the System Properties 
dialog box. 

You should now have your transparent icons back. 

 

 

Configure the Windows XP logon screen saver
This tip applies to both Windows XP Home and Windows XP Professional. As always, remember that editing the 
registry is risky, so be sure to back up your computer before undertaking any registry changes. 

If you ever work in a computer lab or an Internet café where systems regularly sit idle waiting for someone to log 
on, you know that Windows XP will display the Logon dialog box or the Welcome screen for 10 minutes before 
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running the default logon screensaver—the Windows XP logo floating on a black background. You can change 
the default logon screensaver to something different, such as the OpenGL 3D Pipes screensaver, and you can 
shorten the amount of time Windows XP waits before activating it. Here’s how to do both: 

1. Launch the Registry Editor (Regedit.exe). 

2. Go to HK_USERS\.DEFAULT\Control Panel\Desktop. 

3. Locate and double-click the SCRNSAVE.EXE string value. 

4. In the Edit String dialog box, type the name of the screensaver you want in the Value Data text box and click 
OK. 

5. Locate and double-click the ScreenSaveTimeOut string value and change the value from 600 seconds to 
another number, such as 120 for two minutes. 

6. Close the Registry Editor and restart Windows XP. 

After the system restarts and you see the Logon or Welcome screen, leave the system untouched for two minutes 
to see your new screensaver in action. 

 

 

Increase your Command Prompt scrolling capability with the List command
This tip applies only to Windows XP Professional. 

The More command on the Command Prompt in Windows XP Pro (go to Biglogfile.txt | More) allows you to view a 
long text file one screen at a time. But it’s easy to overshoot the information you need due to the overwhelming 
amount of data you may scroll through. When that happens, you have to cancel the operation and start over. The 
More command only allows you to scroll down through a file. 

A command-line tool called List allows you to scroll both up and down through a file. List is not found in Windows 
XP; it’s a part of the Windows Server 2003 Resource Kit Tools. Luckily, the Windows Server 2003 Resource Kit 
tools also work in Windows XP, so you can use the List command on your system. Here’s how: 

1. Download Windows Server 2003 Resource Kit Tools. 

2. Double-click the RKTools.exe self-installer and follow the onscreen instructions. 

3. Once you have the Windows Server 2003 Resource Kit Tools installed, you can use the List command at the 
Command Prompt by typing List followed by the name of the file that you want to scroll through. For example, 
you can scroll through a big log file using the List command List Biglogfile.txt. 

4. The Command Prompt window will change into a file viewer and display contents of the file. Use the arrow 
keys as well as the [Page Up] and [Page Down] keys to scroll through the file. 

5. To exit List, type Q or press [Esc]. 
 

 

Take advantage of Windows XP Pro’s multiple monitor support for Remote 
Desktop Connection
This tip applies only to Windows XP Professional.

If you manage Windows XP Pro systems via Remote Desktop Connection (RDC) with multiple monitors, you’ll 
want to get the newest version of RDC (Terminal Services Client 6.0) because of its invaluable support for 
multiple monitors. 

After you download RDC (Terminal Services Client 6.0), you can use it from your multiple monitor system and 
span the desktop of the remote computer across the multiple monitors on your local system. 
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Two caveats: Your multiple monitors must have the same screen resolution, and the screen resolution on your 
multiple monitors and the monitor of the computer to which you’re connecting must be under 4096 x 2048. 

Follow these steps to launch RDC with multiple monitor support: 

1. Open a Command Prompt window and type the command Mstsc /span. 

2. Fill in the connection settings in the standard RDC dialog box. 

3. Once you’re connected, you can toggle between RDC’s new multiple monitor display and a regular window by 
pressing [Ctrl][Alt][Break]. 

 
 

Use Microsoft Media Player for your Windows XP apps
This tip applies to Windows XP Home and Windows XP Professional.  

Windows XP’s original multimedia player, Microsoft Media Player 5.1, still remains on the operating system 
despite various updates. (Windows Media Player 11 is the most current version of Microsoft’s multimedia player.) 
While Microsoft Media Player is pretty basic by today’s standards, it still serves a purpose. 

Microsoft Media Player can play a number of multimedia file types, such as AVI, WMA, WMV, MID, and WAV, so 
you may want to use it in situations where you don’t need the full power of Windows Media Player. To use 
Microsoft Media Player, add it to the SendTo menu by following these steps: 

1. Press [Windows]R to open the Run dialog box. 

2. Type SendTo in the Open box and click OK. 

3. When the SendTo folder appears, right-click the folder and select the New | Shortcut command. 

4. When the Create Shortcut wizard appears, type C:\Windows\system32\Mplay32.exe /Play in the text box and 
click Next. 

5. Name the shortcut Microsoft Media Player and then click Finish. 

Now when you encounter an AVI, WMA, WMV, MID, or WAV file and you just want to sample it, you can right-
click the file and select the SendTo | Microsoft Media Player command. 

 
 

Copy and paste from Windows XP Pro’s command prompt straight to the 
Clipboard
This tip applies only to Windows XP Professional. 

If you need to copy output from a command and paste it into a Windows program, such as Notepad, while 
working at the Command Prompt, chances are you’ll try to use the Mark and Copy commands on the Command 
Prompt’s Edit menu. A better way to get information from a Command Prompt and onto the Clipboard is the 
Clip.exe command-line tool. 

Clip.exe comes with Windows Server 2003, but it also works in Windows XP Professional. Simply copy Clip.exe 
from the Windows\System32 directory on a Windows Server 2003 system and paste it into the 
Windows\System32 directory on a Windows XP system. (If you don’t have access to Windows Server 2003, you 
can download a copy of Clip.exe from Daniel Petri’s IT Knowledgebase site.) 

Once you have a copy of Clip.exe on your Windows XP system, using it is as easy as appending the pipe and the 
clip command (| clip) to the end of your command line. For example, you can use this command to copy the 
directory listing to the clipboard (Dir | clip), or you can use it to collect, copy, and paste the results of the Ipconfig 
command (Ipconfig /all | clip). 
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Implementing User Account Control-type protection in Windows XP
This tip is for both Windows XP Home and Professional. 

To protect Windows Vista from malware and inadvertent disastrous mistakes, Microsoft endowed the operating 
system with the User Account Control (UAC) system. This system requires all users to use the standard user 
mode and then prompts for administrator credentials before performing an operation. 

If you like the idea of the UAC system but you’re not ready to upgrade to Windows Vista, you can use UAC’s 
predecessor in Windows XP: the RunAs command. Here’s how to use Windows XP’s version of UAC: 

1. Log in as the Administrator. 

2. Launch User Accounts, locate your user account, and change your account type from Computer Administrator 
to a Limited account. 

3. Log out of the Administrator account and log back in with your new Limited account. 

4. Whenever you encounter a situation in which you need administrative credentials, press [Shift] as you right-
click the application’s executable file or its icon and select the RunAs command. 

5. When you see the RunAs dialog box, choose The Following User option to select the Administrator account 
and then type in the password. 

6. Click OK. 

Now you can perform any operation that requires administrator credentials. 

 
 

Customize Windows XP’s General tab
This tip applies to Windows XP Home and Windows XP Professional.

It’s easy to customize Windows XP’s General tab in the System Properties dialog box with your support contact 
information and your company’s logo just by using Notepad. Here’s how: 

1. Launch Notepad and type the following text, replacing the dummy information shown here with your own:  

[General] 

Manufacturer=Jim’s Computers 

Model=5551212 

[Support Information] 

Line1=Call 555-1212 for technical support 

Line2=Call 555-1212 for technical support 

Line3=Call 555-1212 for technical support 

Line4=Call 555-1212 for technical support 

2. Save the file in the C:\Windows\System32 folder as Oeminfo.ini. 

3. To add your logo to the General tab, create a 256-color BMP file that is 96 by 96 pixels in size. 

4. Save the file in the C:\Windows\System32 folder as Oemlogo.bmp. 

After you create the files, you can check the results immediately by pressing [Windows][Break]. This will quickly 
bring up the System Properties dialog box. 
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Get more out of Internet Explorer 7 tabs when using Windows XP

This tip applies to Windows XP Home and Windows XP Professional.  

Many Windows XP users upgraded to Internet Explorer 7 to take advantage of the tabs feature. Here are some 
shortcuts and tricks that you can use to get even more out of Internet Explorer 7’s tabs. 

• While clicking the tabs to switch between them is handy, you can also switch between tabs by pressing 
[Ctrl][Tab]. 

• If you have a wheel mouse, you can open a link in a new tab by clicking the link with the wheel button. 

• While you can start a new tab by clicking the small New Tab button, you can also open a new tab by 
pressing [Ctrl]T. 

• If you’re scanning several sites on multiple tabs and want to return to this same set of tabs at a later date, 
click the Add To Favorites button and use the Add Tab Group To Favorites command. 

• If you have a wheel mouse, you can close any tab by clicking it with the wheel button. 

• When scanning several sites on multiple tabs, you can click and drag the tabs in any arrangement that 
you wish. 
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Additional resources 
• TechRepublic's Downloads RSS Feed  
• Sign up for the Downloads at TechRepublic newsletter 
• Sign up for our Windows XP newsletter  
• Check out all of TechRepublic's free newsletters 
• 10 customization tricks to save you time in Windows XP 
• 10 handy Windows XP efficiency tricks 
• Take charge of Windows XP with these 10+ power tips 
• 10 Windows XP tips and tools to simplify your work 
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Tell us what you think 

TechRepublic downloads are designed to help you get your job done as painlessly and effectively as possible. 
Because we're continually looking for ways to improve the usefulness of these tools, we need your feedback. 
Please take a minute to drop us a line and tell us how well this download worked for you and offer your 
suggestions for improvement. 

Thanks! 

—The TechRepublic Content Team 
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